
Microsoft Excel Readme Help Contents
To learn how to use Help, press F1.
Microsoft Excel Product Update
Late-breaking information about this release of Microsoft Excel.
Network Installations
Instructions for installing Microsoft Excel to run on a network and for creating and saving a 
custom setup for your organization.
Documentation Updates
Late-breaking changes and additions to Microsoft Excel documentation.
Compatibility with Previous Microsoft Excel Versions
Information about using your old files and macros with Microsoft Excel version 5.0.
Microsoft Query Information
Late-breaking information about Microsoft Query.
Files Included with Microsoft Excel
Directions to a file that describes all the files included with Microsoft Excel.

To print a Readme Help topic
1. Display the topic you want in the Help window.
2. From the File menu in the Help window, choose Print Topic.



Microsoft Excel Product Update
If you see the Setup error message "Must Exit Windows and Load SHARE.EXE. . ."
In order to run Microsoft Excel version 5.0, you must have the Share program installed on 
your computer. If you try to run Microsoft Excel when Share is not installed, you will receive 
the following error message:
You must exit Windows and load SHARE.EXE in order to run Microsoft Excel.
If you receive this error message, you can do either of the following:

Add the following line to your AUTOEXEC.BAT file 
<path>\share.exe /l:500 /f:5100
where <path> is the drive and directory where the SHARE.EXE file is located (usually the 
MS-DOS directory). For example, if your MS-DOS directory is called DOS and is on drive C, 
add the following line to your AUTOEXEC.BAT file:
c:\dos\share.exe /l:500 /f:5100
You may need to add this line if it was removed from your AUTOEXEC.BAT file or if Setup 
was unable to add it.

-Or-
If you are running Microsoft Windows for Workgroups, try running in 386 enhanced 

mode.
Avoid problems after you install Microsoft Excel
You may get unpredictable results if you do any of the following:

Rename the directory into which you installed Microsoft Excel
Delete or move any .INI files
Delete or move any .DLL files
Delete or move any of the directories within the Microsoft Excel directory

If you want to change your Microsoft Excel installation, rerun Setup and choose the 
Add/Remove button, and then follow the instructions in Setup.
Avoid problems with workstation or multiple-drive installations
Regardless of the Setup options you choose, Setup must install certain files to your 
WINDOWS directory on your computer's local hard disk. For a full list of these files, see 
FILELIST.TXT on Setup disk 1. If your computer's hard disk does not have enough space for 
these files, you will not be able to complete Setup.
Setup removes Microsoft Excel version 4.0 files
If you install Microsoft Excel 5.0 into a directory that contained a previous version of 
Microsoft Excel and:

If you upgrade from version 4.0, Setup will replace or remove most version 4.0 files. 
Setup will not remove or replace the Dialog Editor or Crosstab-related files.

If you upgrade from a version of Microsoft Excel previous to 4.0, Setup will leave all 
files that it does not replace.
Both cases above apply only to application files, not your data files such as worksheets.
Error message when running the Examples and Demos?
If you get an error message that refers to insufficient GDI resources when you attempt to 
start an Examples and Demos lesson, here are some things you can do:

Remove your Windows Wallpaper. Start the Control Panel, Desktop application.
Close other open applications, then try to start the lesson again.
If you are using a 256 color and hi-resolution driver, try installing the 16 color VGA 

driver. See your Windows documentation for more information.



If you are running a Windows shell that replaces Program Manager, disable or remove
it. See your shell's documentation for more information.

Some screen savers affect the Examples and Demos if they are activated during a 
lesson. If you experience problems with a screen saver, disable it before starting a lesson.
To run the Examples and Demos with the lowest memory requirements, try starting the 
lesson from Help without starting Microsoft Excel.
To start Examples and Demos directly from Help
1. In File Manager, open the directory in which you installed Microsoft Excel.
2. Double-click the file MAINXL.HLP.
3. Choose Examples and Demos, and then complete the lesson you want.
Getting ODBC function help from Object Browser
When in the Object Browser, you will not be able to display function help for the XLODBC 
add-in directly. You may see a "Cannot Open Help File" alert message.
To display a specific SQL function help topic, first display the Visual Basic Reference Help. 
Then search for a specific function, for example SQLBind.
Getting ODBC Driver Help
When in the ODBC Driver Reference Help topic, you cannot jump to the specific driver Help 
topics. If you attempt to do so, you may see the following alert message: "Microsoft Excel 
Help could not find the file DRVxxxxx.HLP. You will have to install it using Setup." This 
message is incorrect; reinstalling the DRVxxxxx.HLP file will not solve the problem.
To view an ODBC driver Help topic, open its Help file directly from File Manager. All ODBC 
driver Help files follow the naming convention DRV?????.HLP and are installed in your 
WINDOWS\SYSTEM directory. Simply double-click the file you want to open it in Help.
Special notes on using Microsoft Excel version 5.0 with other software

Windows NT
For best results using Microsoft Excel 5.0 on Windows NT version 3.10 (or Windows NT 
Advanced Server), please install Windows NT Service Pack 1 or higher. To verify the exact 
version of Windows NT, run WINVER.EXE from the Windows NT command prompt. The 
second line of the WINVER dialog box should read "Version 3.10 (build 528: CSD002)" or 
higher. Windows NT Service pack 1 is available on CompuServe and via anonymous FTP on 
the Internet, as well as from Microsoft. For additional information on obtaining Windows NT 
Service Pack 1, consult Your Guide to Service and Support for Microsoft Windows NT, 
included with Windows NT.

Note that the Examples and Demos online lessons are not available for Windows NT.
OS/2

If you attempt to start Microsoft Excel and see the "No Timer Driver Installed" alert 
message, note that
Microsoft Excel cannot run without the Timer driver installed. To install the driver:

1. Double-click the Control Panel icon to run the Microsoft Windows Control Panel. If you 
do not have an icon for the Control Panel, run the file CONTROL.EXE from the Program 
Manager.
2. In the Control Panel window, double-click the Drivers icon.
3. If the Timer driver is not in the list of installed drivers, choose the Add button.
4. Select Timer from the list of drivers and then choose the OK button. If the driver does
not exist on your system, the program will ask you to insert the appropriate Microsoft 



Windows setup disk into one of your floppy disk drives; follow the instructions in the 
dialog box.
5. Choose the Close button in the Drivers dialog box.
6. Close the Control Panel, and then restart Microsoft Windows.
7. Restart Microsoft Excel.

Note that the Examples and Demos online lessons are not available for OS/2.
Lotus cc:Mail or Lotus Notes

Microsoft Excel supports Vendor Independent Messaging (VIM) 1.0, which means that you 
can use the Send and Add/Edit Routing Slip commands (File menu) in Microsoft Excel to 
send or route Microsoft Excel documents with mail applications such as Lotus cc:Mail that 
support VIM 1.0. VIM is automatically installed by cc:Mail version 2.0 (or greater) and Notes
version 3.0 (or greater). Lotus cc:Mail 1.11 users may get VIM support files from Lotus. The 
DOS PATH command in the AUTOEXEC.BAT file must include the directory in which the mail 
application's VIM support files are stored. Otherwise, Setup will not install Microsoft Excel 
support for VIM. If Microsoft Excel support has already been installed, it will not function 
correctly if the VIM directory is not included in the DOS PATH command. The Microsoft Excel
support file for VIM 1.0 is called MAPIVIM.DLL and is stored in the System subdirectory of 
the Windows program directory.
If you have a system with a large number of users in the address book, you can improve 
performance by adding a switch in the WIN.INI to disable the listing of names in the address
dialog. To do this, add the entry: MAPIVIMDisableABScan=1 to the [Mail] section of the 
WIN.INI. This will not show the address book's list of users, which will greatly improve the 
speed of the address dialog.

DoubleDisk Gold
If you have installed DoubleDisk Gold on your hard disk, note the following. The Microsoft 
Excel Setup program will add a SHARE command and parameters to your AUTOEXEC.BAT 
file, if it is not there already. However, the DoubleDisk Gold startup controller may not 
recognize the SHARE command, preventing Microsoft Excel from starting properly. To fix 
this problem, edit your AUTOEXEC.BAT file and move the line that contains SHARE 
command below the command that interchanges the drives. Make this correction to the 
AUTOEXEC.BAT files on both your C: and D: drives, and then restart your computer.
Macros that call Microsoft Excel 4.0 add-ins
Several Microsoft Excel version 4.0 add-ins are not available with Microsoft Excel version 
5.0. Their functionality has been incorporated directly into Microsoft Excel. Most of your 
Microsoft Excel version 4.0 macros should run properly in Microsoft Excel version 5.0 
without modification, because Microsoft Excel translates their function calls automatically.
If you have macros that include functions from the Analysis ToolPak (ANALYSIS.XLA and 
ANALYSF.XLA), Scenario Manager (SCENARIO.XLA) or Add-In Functions (ADDINFNS.XLA) 
addins, however, you should use the Link Changer included with Microsoft Excel 5.0 to 
update reference to these add-ins. For information about the Link Changer, see "Changing 
Links to Microsoft Excel version 4.0 addins" in the Microsoft Excel Macro Functions Help.
Using arrays with Microsoft Windows country settings other than US
If the list separator specified by your Microsoft Windows country setting conflicts with the 
array separators used by Microsoft Excel, then columns in arrays are separated by a 
backslash (\) and rows are separated by a semi-colon (;). For example, the following is a 
three-column array that uses these alternate separators:
{1\2\3;4\5\6}



Information for experienced Microsoft Excel macro writers
A list of macro functions and Visual Basic Equivalents for Macro Functions and Commands 
can be found in the Microsoft Excel Macro Functions help. To access this information:
1. Press F1, or select the "Contents" command from the Help menu.
2. From the Help Contents, select "Reference Information."
3. Select "Microsoft Excel Macro Function Contents"
Note  The above information will is not available with a "Typical" or "Minimum" installation.
To install this component, rerun the MS Excel Setup program, choose the "Add/Remove" 
button, check "Online help and lessons," then choose the "Change Option" button. From the
list of online help options, check "Help for Microsoft Excel 4.0 Macros," then choose OK.
Dates and Financial Functions
The Analysis ToolPak includes many worksheet functions for performing financial 
calculations. Several of these functions use dates as arguments. In Microsoft Excel version 
5.0, you can now specify these date arguments as text, such as "2/3/1994". Previously, you 
could specify date arguments as serial numbers only.
Unrecognized System Locales
In order for Visual Basic, Applications Edition to adapt its behavior to your system locale 
(Control Panel settings), it must recognize your system locale. The following system locales 
are recognized.
Language Country
Czech Czech Republic
Danish Denmark
Dutch Netherlands

Belgium
English US

UK
Australia
Canada
New Zealand

Finnish Finland
French France

Belgium
Canada
Switzerland

German Germany
Switzerland
Austria

Hungarian Hungary
Italian Italy

Switzerland
Norwegian Norway (Bokmal)
Norwegian Norway (Nynorsk)
Polish Poland
Portuguese Portugal



Brazil
Russian Russia
Spanish Mexico

Spain (Castilian)
Spain (Modern)

Swedish Sweden

If Visual Basic, Applications Edition does not recognize your system locale, it will default to 
English/US system locale behavior. This will have the following results:

All VBA output will be based on English/US locale settings (for example. the format of 
printed dates).

Locale aware functions will behave based on English/US locale settings. For example, 
the CDate function will attempt to convert strings to dates according to the English/US locale
conventions.

InStr and Like will default to English/US behavior. The StrComp function uses system 
comparison routines and will therefore behave according to your system locale.



Network Installations

Depending on your Microsoft licensing agreement, you have several network installation 
options. For a full description of these options and installation instructions, see the file 
NETWORK.TXT. You can open this in Notepad or any text editor or word processor.
You can find NETWORK.TXT in two locations:

On Setup disk 1. It is not compressed, so you can open it directly from the floppy 
disk.

In the directory in which you installed Microsoft Excel version 5.0, for example the C:\
EXCEL directory.



Documentation Updates

The following errors in printed documentation were discovered after the books were 
printed. Please mark the changes in your copies of the books. We apologize for any 
inconvenience.
Book: Microsoft Excel User's Guide
Page: xviii
Chapter: Microsoft Support Services
Note the following changes and corrections to Microsoft subsidiary offices:
Under Australia, the correct Sales Information Centre number should be (61) (02) 870-2100.
Under Denmark and Finland, disregard the FAX numbers listed.
Under Mexico, disregard the Technical Support number listed. The correct technical support
number for desktop applications and operating systems is (52) (5) 325-0912.
Under Norway and Sweden, disregard the FAX numbers listed.

Page: 39
Chapter: 3
Under the heading "Translating 1-2-3 Macros in Microsoft Excel," the last procedure on page
39, "To run a translated 1-2-3 macro" is incorrect. Steps 4, 5, and 6 (which continue on 
page 40) should read:
4. From the Tools menu, choose Macro.
5. In the Macro Name box, select the macro you want to run.
6. Choose the Run button.

Page: 46
Chapter: 4
Under the heading "New Features for Exchanging Data with Other Applications," the last 
line on the page suggests that you can save files in Multiplan and Microsoft Works format, 
which is incorrect. You can, however, open files in Multiplan and Microsoft Works format.

Page: 67
Chapter: 6
Under the heading "Saving a Workbook in Another File Format," the last sentence on the 
page suggests that you can save files in Microsoft Works format, which is incorrect. You 
can, however, save files in Lotus 1-2-3 format.

Page: 230
Chapter: 13
Under the heading "Polygons," the last sentence on the page should be:
"To add a vertex, hold down CTRL (Windows) or OPTION (Macintosh) while you drag a line."

Page: 254
Chapter: 14



Under the heading "Creating and Printing Reports," the first paragraph mentions that 
Microsoft Excel displays the Add Report dialog box automatically if no reports have been 
previously defined for the active workbook. This is incorrect. You must choose the Add 
button in the Print Report dialog box to display the Add Report dialog box.

Page: 474
Chapter: 24
Under the heading "Select the Worksheet Destination and Display Options," add the 
following to the second paragraph:
To create the pivot table on a new worksheet, leave the PivotTable Starting Cell box blank.

Page: 567
Chapter: 29
Under the heading "Specify the Constraints," the third bullet item at the top of the page 
should read:
For each problem, you can specify two constraints for each changing cell (one upper-limit 
and one lower-limit constraint), plus up to 100 additional constraints.

Page: 612
Chapter: 32
Under the heading "Zooming In or Out On a Worksheet," the last sentence before the 
heading "Guidelines for Zooming a Worksheet" should be:
"When you want to unhide the hidden screen elements, click the Full Screen button or 
choose the Full Screen command again."

Page: 640
Chapter: 34
Under the heading "Using Custom Colors in Custom Number Formats," change the example
"[Color9]General" to "[Color8]General."

Page: 657
Chapter: 36
Under the heading "Using an Autotemplate to Insert Your Own Default Sheets," note that 
autotemplates for modules are not supported. In the tables on pages 657 and 658, delete 
the entries for Module sheet types.
Book: Microsoft Excel Visual Basic User's Guide
Page: 37
Chapter: 2
Under the heading "Changing the State of and Option," the first line in the second 
subroutine should be:

Sub SetGridlines()
Note that there should be no space after "Set."

Page: 38



Chapter: 2
Under the heading "Copying a code example from Help," the procedure "To copy a code 
example from help" should read as follows:
1. With a Visual Basic module active, place the cursor in the Visual Basic keyword for which 

you want an example.
2. In Microsoft Excel for Windows, press F1. In Microsoft Excel for    the Macintosh, press 

Command+1.
The Help topic for the keyword appears.

3. At the top of the Help window, click the word "Example," as shown in the following 
illustration.

4. In the Example window, choose the Copy button.
Help displays a Copy dialog box.

5. Select the portion of the example you want to copy.
6. Choose the Copy button.
7. Return to your Visual Basic module.
8. Position the insertion point where you want to paste the code.
9. From the Edit menu, choose Paste.

Page: 63
Chapter: 4
Under the heading "Protecting modules from calls by procedures in other workbooks," the 
Tip should read as follows:
Users of your workbook rarely need to see its private modules, so you might want to hide 
them completely. You can hide a Visual Basic module by choosing the Sheet Hide command
from the Edit menu.

Page: 97
Chapter: 6
Under the heading "Checking the Type of Data Stored in a Variable," the first code example 
under the heading should be:

If TypeName(NumberOfUnits) = "Integer" Then
'Do something to an integer.

End If

Page: 99
Chapter: 6
Under the heading "Assigning Cells and Ranges of Cells (as Objects) to Variables," delete 
the first line in the last code example on the page.

Page: 160
Chapter: 8
Under the heading "Using Step Into," the last sentence in the paragraph preceding the Note
should read as follows:
When the procedure being called is in an Add-in or in a module with its Visible property set 
to xlVeryHidden, Step Into behaves as Step Over does.



Page: 274
Chapter: 13
Under the heading "OnEntry Property," the second line of the code example should be:
ActiveWorkbook.Worksheets("GeneCountDB").OnEntry = _

Page: 276
Chapter: 13
Under the heading "OnRepeat and OnUndo Methods," the .Value statement in the second 
subroutine on the page should be:

.Value = .Offset(-1, 0) + 1 'Add a day.
Note that there should be a space between the comma and the zero of the .Offset 
arguments.

The following errors in online Help were discovered after the Help files were completed. 
Please note the following changes in your Help files. We apologize for any inconvenience.

Page: 301
Chapter: Appendix B
Under the heading ""Creating Add-in Applications,"    add the following:
Macros that call Microsoft Excel 4.0 add-ins
Several Microsoft Excel version 4.0 add-ins are not available with Microsoft Excel version 
5.0. Their functionality has been incorporated directly into Microsoft Excel. Most of your 
Microsoft Excel version 4.0 macros should run properly in Microsoft Excel version 5.0 
without modification, because Microsoft Excel translates their function calls automatically.
If you have macros that include functions from the Analysis ToolPak (ANALYSIS.XLA and 
ANALYSF.XLA), Scenario Manager (SCENARIO.XLA) or Add-In Functions (ADDINFNS.XLA) 
addins, however, you should use the Link Changer included with Microsoft Excel 5.0 to 
update references to these add-ins.
For information about the Link Changer, see "Changing Links to Microsoft Excel version 4.0 
addins" in the Microsoft Excel Macro Functions Help.
Book: Microsoft Query User's Guide
Page: 48
Chapter: 3
Under the heading "Selecting Data," in the table "Using the Keyboard" the item "More than 
one field (column)" should read as follows:
Press CTRL+SPACEBAR in Microsoft Query for Windows or COMMAND+SPACEBAR in 
Microsoft Query for the Macintosh, and then press SHIFT+RIGHT ARROW or SHIFT+LEFT 
ARROW.
Help: Microsoft Excel Help

SQLREQUEST topic
The SQLREQUEST function has been renamed SQL.REQUEST (with a period between the L 
and R). No other changes were made to its syntax.
Help: Visual Basic Reference



Changes to Visual Basic Reference help
1. In the Application Object topic, ignore the last paragraph; the Global object does not 

exist.
2. The example for the Update Method topic should be:
This example updates all linked OLE objects on the active sheet.
For Each obj In ActiveSheet.OLEObjects

If obj.OLEType = xlOLELink Then obj.Update
Next
3. In the first example for the Borders Method topic, add the following line to the example 

code, before the line that is already in the example:
Application.Range("A1:A10").Borders(xlBottom).Weight = xlThick
4. The following help topic was omitted from the Visual Basic Reference help:

MacroOptions Method

Applies To
Application
Description
Corresponds to options in the Macro Options dialog box.
Syntax
object.MacroOptions(macro, description, hasMenu, menuText, hasShortcutKey, 
shortcutKey, category, statusBar, helpContextId, helpFile)
Elements
The MacroOptions method has the following object qualifier and named arguments:
object

Required. The Application object.
macro

Required. The name of the macro to set options for, as a string.
description

Optional. The description of the macro, as a string.
hasMenu

Optional. If True, then a menu item is automatically added to the Tools menu for this 
macro. If True, then menuText must also be specified. If False or omitted, no menu 
item is added for the macro. If the macro already has a menu item created for it, setting 
this argument to False will remove the menu item.

menuText
Required if hasMenu is True; ignored otherwise. The text of the menu item, as a string.

hasShortcutKey
Optional. If True, a shortcut key is assigned to the macro. If True, then shortcutKey 
must also be specified. If False or omitted, no shortcut key is assigned to the macro. If 
the macro already has a shortcut key, setting this argument to False will remove the 
shortcut key.

shortcutKey



Required if hasShortcutKey is True; ignored otherwise. The shortcut key (first character
only) as a string.

category
Optional. The function category (Financial, Date & Time, User Defined, and so on) that 
the macro appears in, as an integer.

statusBar
Optional. The status bar text for the macro, as a string.

helpContextId
Optional. The context id for the Help topic assigned to the macro, as an integer. The 
context ID also applies to any menu items and/or toolbar buttons assigned to the macro.

helpFile
Optional. The name of the Help file that contains the Help topic defined by 
helpContextId, as a string.

Help: Microsoft Excel Macro Functions
Following is a new function description that does not appear in the Microsoft Excel Macro 
Functions Help.
MACRO.OPTIONS
Equivalent to choosing the Options button in the Macro dialog box, which appears when 
you choose Macro command from the Tools menu.

Syntax
MACRO.OPTIONS(macro_name, description, menu_on, menu_text, shortcut_on, 
shortcut_key, function_category, status_bar_text, help_id, help_file)
Macro        is the name of the macro that you want to set options for, including the name of 
the workbook and sheet containing the macro.
Description        is the description of the macro displayed in the Macro dialog box.
Menu_on        is a logical value indicating whether a menu item is automatically added for 
this macro. If TRUE, menu_text must be specified. If FALSE or omitted, no menu item is 
added. If the macro already has a menu item, setting this argument to FALSE removes the 
menu item.
Menu_text        is the text of the menu item to be added for the macro. Ignored unless 
menu_on is TRUE.
Shortcut_on        is a logical value indicating whether a shortcut key is assigned to the 
macro. If TRUE, shortcut_key must be specified. If FALSE or omitted, no shortcut key is 
assigned. If the macro already has a shortcut key, setting this argument to FALSE removes 
the shortcut key.
Shortcut_key        is the letter of the shortcut key for the macro. Ignored if shortcut_key is 
FALSE.
Function_category        is the number of the category in the Function Wizard that the macro 
is assigned to. Categories are numbered starting at 1 for the category at the top of the list 
in the Function Wizard.
Status_bar_text        the text displayed in the status bar when a menu item or toolbar button 
assigned to this macro is clicked on. Be sure to enclose the text in quotes.
Help_id        is the numerical id for the help topic associated with this macro and any related 
menu items or toolbar buttons.
Help_file        is the pathname of the help file for the macro.





Compatibility with Previous Microsoft Excel Versions
File Compatibility
Microsoft Excel version 5.0 reads all existing Microsoft Excel version 2.x through 4.x 
documents. However, documents saved in Microsoft Excel version 5.0 format cannot be 
opened in Microsoft Excel version 4.0a or earlier. To open a document in an earlier version 
of Microsoft Excel, choose the Save As command from the File menu, and select the 
"Microsoft Excel 4.0 Workbook" or other file format you want.
Note You may lose some formulas and formatting when the document is saved in an earlier
format.
Macro Compatibility
Macros developed in previous versions of Microsoft Excel are fully compatible with Microsoft
Excel version 5.0. However, some Microsoft Excel 4.0 add-ins are no longer supported as 
add-ins; their functionality has been included directly in Microsoft Excel 5.0. For information
about these add-ins, see "Macros That Call Microsoft Excel 4.0 Add-ins" in the Microsoft 
Excel Product Update topic.



Microsoft Query Information
ToolTips
To help you learn the buttons on the toolbar, Microsoft Query has a feature called ToolTips, 
which is on by default. When ToolTips is on, captions displaying the name of each toolbar 
button appear below the mouse pointer as you move the pointer over each button.
To turn ToolTips off or on

From the View menu, choose ToolTips.
ToolTips is on when the command is checked.



Files Included with Microsoft Excel

The file FILELIST.TXT lists the files included in Microsoft Excel version 5.0. This is a tab 
delimited text file, so you can open it in Notepad or any other text editor, word processor or
spreadsheet. You can find FILELIST.TXT in two locations:

On Setup disk 1. It is not compressed, so you can open it directly from the floppy 
disk.

In the directory in which you installed Microsoft Excel version 5.0, for example the C:\
EXCEL directory.




